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Breve introduzione all’uso di OrCAD PSpice 9.1 
 

Introduzione 

Il presente tutorial riassume brevemente le nozioni di base per l’uso di OrCAD PSpice 9.1 
Student Edition come strumento per la soluzione numerica di semplici esercizi di elettrotecnica. 

È possibile scaricare la versione 9.1 Student del sofware (distribuibile liberamente, 27Mb) 
all’indirizzo: 

http://www.web-ee.com/Downloads/Simulator/simulation.htm 
Il sito di riferimento di OrCAD PSpice (dal quale è anche possibile scaricare la versione 10.5 

demo, non liberamente distribuibile, 280Mb) è il seguente: 
http://www.orcad.com 
Nell’ambito di questo tutorial verrà utilizzata la versione 9.1. L’utilizzo della versione 10.5 è 

comunque molto simile alla 9.1 per quanto riguarda le funzionalità utilizzate. 
 

Installazione 

Cliccare due volte sul file “91PSPSTU.EXE”, immettere il nome della cartella in cui si vuole 
copiare i file di installazione (si consiglia di modificare la voce di default) e cliccare su “Unzip”, e 
poi su “Close”. Aprire la cartella indicata con il file manager e lanciare il file “Setup.exe”. Seguire 
le istruzioni (scegliere “Capture” come editor quando viene chiesto). 

 

Avviare l’editor degli schematics (capture) 

L’interfaccia grafica utilizzata per la realizzazione dei circuiti è il programma “Capture”. Per 
avviare l’editor nel menù di windows cercare la voce “PSpice Student” e selezionare “Capture 
Student”. 

 

Creazione di un nuovo progetto 

Dal menù selezionare “File > New > Project” (oppure cliccare l’icona  della toolbox in alto). 
Alla voce “Name” immettere il nome del progetto; nel menù a scelta multipla selezionare “Analog 
or Mixed A/D”; alla voce “Location” immettere il nome del cartella in cui si vuole salvare. PSPice 
chiede se si vuole creare il nuovo progetto sulla base di un progetto esistente. Per creare un nuovo 
progetto vuoto selezionare “Create a blank project”. Il nuovo progetto viene creato di default con 
uno “schematic” di nome “SCHEMATIC1” e una pagina di nome “PAGE1”. È possibile modificare 
i nomi dello “schematic” e della pagina tramite il menù contestuale (cliccando con il tasto destro del 
mouse), così come aggiungere altri schematics o altre pagine al progetto. Ai fini del presente 
tutorial, data la semplicità dei circuiti proposti non è necessario utilizzare più schematics o più 
pagine, e possono essere mantenuti i nomi di default. 

 
ATT: non utilizzare spazi nei percorsi di cartella e nei nomi di file. 
 
ATT: per aprire un progetto esistente dal menù selezionare “File > Open > Project” (oppure 

cliccare sull’icona  della toolbox in alto) e selezionare il file del progetto (estensione “.opj”). 
Viene aperto il project manager, che raccoglie tutti i file relativi al progetto. Per visualizzare il 
circuito, cliccare due volte sul file con estensione “.dsn”, poi sul nome dello schematic (in genere 
“SCHEMATIC1”) e infine sul nome della pagina che contiene il circuito (in genere “PAGE1”). 
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Inserimento dei componenti del circuito 

I componenti sono raccolti in librerie. Per poter inserire un componente in un progetto occorre 
prima selezionare la relativa libreria. Dal menù selezionare “Place > Part” (oppure cliccare 

sull’icona  della toolbox a destra, oppure premere il tasto “p”). Se la voce “Libraries” non 
contiene la libreria del componente da inserire, premere “Add Library” per aggiungerla. Una volta 
aggiunta la libreria, selezionarla per mostrare la lista dei componenti che comprende. Per inserire un 
componente, selezionarlo e premere “OK” (oppure cliccare due volte sul componente). Spostare la 
freccia del mouse nel punto desiderato e premere il tasto sinistro. Se si desidera ruotare il 
componente premere il tasto “r”. Per terminare l’inserimento premere il tasto “ESC”. 

Di seguito è riportata una lista dei componenti principali usati nei circuiti di elettrotecnica 
trattati, assieme ad informazioni sul nome e sulla libreria che li contiene. Per ricercare altri 
componenti dalla finestra “Place Part” selezionare “Part Search” e introdurre il nome da cercare (è 
possibile utilizzare gli usuali caratteri wildcard “*” e “?” per la costruzione di patterns di ricerca). 

 
 
 

Componente Name Library Valori da impostare / note 

Resistore R Analog Resistenza. 
Induttore L Analog Induttanza. 
Condensatore C Analog Capacità. 
Generatore 
indipendente di 
tensione DC 

VDC Source Tensione DC. 

Generatore 
indipendente di 
corrente DC 

IDC Source Corrente DC. 

Generatore 
indipendente di 
tensione AC 

VSIN Source Componente continua (VOFF, 
generalmente da impostare a zero), 
ampiezza (VAMPL), frequenza 
(FREQ). Nota: se occorre impostare la 
fase, cliccare due volte sul simbolo e 
inserirla alla colonna PHASE (in gradi). 

Generatore 
indipendente di 
corrente AC 

ISIN Source Componente continua (IOFF, 
generalmente da impostare a zero), 
ampiezza (IAMPL), frequenza (FREQ). 
Nota: se occorre impostare la fase, 
cliccare due volte sul simbolo e inserirla 
alla colonna PHASE (in gradi). 

Generatore di tensione 
pilotato in tensione 

E Analog Per impostare il guadagno cliccare due 
volte sul simbolo, e inserirlo alla 
colonna “GAIN”. 

Generatore di corrente 
pilotato in corrente 

F Analog Per impostare il guadagno cliccare due 
volte sul simbolo, e inserirlo alla 
colonna “GAIN”. 

Generatore di corrente 
pilotato in tensione 

G Analog Per impostare il guadagno cliccare due 
volte sul simbolo, e inserirlo alla 
colonna “GAIN”. 

Generatore di tensione 
pilotato in corrente 

H Analog Per impostare il guadagno cliccare due 
volte sul simbolo, e inserirlo alla 
colonna “GAIN”. 
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Amplificatore 
operazionale 

(non presente)  Occorre realizzare il circuito 
equivalente mediante un generatore di 
tensione pilotato in tensione. Ricordarsi 
di collegare i circuiti non connessi, 
oppure assegnare un nodo di riferimento 
per ognuno di essi. 

Trasformatore ideale (non presente)  Occorre realizzare il circuito 
equivalente mediante due generatori 
pilotati. Ricordarsi di collegare i circuiti 
non connessi, oppure assegnare un nodo 
di riferimento per ognuno di essi. 

Trasformatore 
“induttori accoppiati” 
(senza perdite) 

XFRM_LINEAR Analog Per impostare l’induttanza del primario 
(L1), del secondario (L2), e il fattore di 
accoppiamento (“COUPLING” = 

L2L1M/ ), cliccare due volte sul 

simbolo e modificare le relative 
colonne. 

Diodo ideale Dbreak Breakout Selezionare il componente, dal menu 
selezionare “Edit > PSpice Model”, 
modificare le proprietà del modello del 
diodo nelle seguenti: 
“.model Dbreak D N=1u Vj=1u”. 
Salvare e chiudere il model editor. 
Per informazioni sul modello e le 
proprietà del diodo e degli altri 
componenti implementati in PSpice 
vedere la “PSpice Reference Guide”. 

 
Dopo aver inserito i componenti, occorre impostare i valori (vedi tabella). Per le proprietà i cui 

valori sono riportati sullo schema del circuito basta cliccare due volte col tasto sinistro sul valore di 
default visibile accanto al componente. In questo modo è anche possibile modificare i nomi, ma 
occorre fare attenzione che nel circuito non compaiano due componenti con lo stesso nome. 
Cliccando due volte sul simbolo del componente si apre la finestra dell’editor delle proprietà, in cui 
è possibile impostare anche valori aggiuntivi non visibili direttamente sullo schema del circuito 
(vedi tabella). I multipli e sottomultipli delle unità di misura fondamentali (nel Sistema 
Internazionale) possono essere inseriti con la seguente notazione: 

- tera (1012 = 1 000 000 000 000): T 
- giga (109 = 1 000 000 000): G 
- mega (106 = 1 000 000): MEG 
- kilo (103 = 1 000): k 
- (unità fondamentale) (1): (nessun suffisso) 
- milli (10−3 = 0.001): m 
- micro (10−6 = 0.000 001): u 
- nano (10−9 = 0. 000 000 001): n 
- pico (10−12 = 0. 000 000 000 001): p 
- femto (10−15 = 0. 000 000 000 000 001): f 

Ad esempio, il valore di resistenza di 1kΩ si inserisce con “1k”, il valore di induttanza di 3mH si 
inserisce con “3m”. 

 
ATT: PSpice usa i versi di riferimento associati di tensione e corrente con la convenzione degli 

utilizzatori per tutti i componenti. Il verso positivo della corrente in un bipolo è quindi sempre 
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entrante nel morsetto positivo e uscente da quello negativo. Nei generatori il segno dei morsetti (e 
quindi anche il verso della corrente) è chiaramente indicato sullo schema del circuito. Nei 
componenti passivi (resistori, induttori, condensatori ecc.) il segno dei morsetti non è invece 
generalmente visibile. Ciò può determinare errori di segno quando si valutano i risultati delle 
simulazioni. È possibile determinare il segno associato a un morsetto di un bipolo passivo cliccando 
due volte col tasto sinistro del mouse sul morsetto: si apre il “Property editor”, e sotto la colonna 
“Name” è indicato il valore “1” oppure “2”. Il morsetto “1” è quello positivo: la corrente che 
attraversa il bipolo viene considerata positiva quando entra nel morsetto “1” ed esce dal morsetto 
“2”. Per evitare errori, è consigliabile aggiungere un simbolo “+”sullo schema del circuito accanto 
al morsetto “1” di ciascun bipolo passivo. Dal menù selezionare “Place > Text” (oppure cliccare 

sull’icona  della toolbox a destra, oppure premere il tasto “t”), digitare il carattere “+” da 
immettere, cliccare su “OK” e poi immettere la casella di testo accanto al morsetto. 

 

Collegamento dei componenti 

Per inserire i collegamenti fra i componenti, dal menù selezionare “Place > Wire” (oppure 
cliccare sull’icona  della toolbox a destra, oppure premere il tasto “w”). A questo punto puntare 
il primo piedino, fare click, andare al secondo piedino e rifare click: i due pin vengono così 
connessi. Per tracciare un collegamento composto da più tratti ortogonali, cliccare col tasto sinistro 
in corrispondenza degli estremi dei vari tratti. Per terminare l’inserimento premere il tasto “ESC”. 
Per modificare un tratto una volta terminato l’inserimento, selezionarlo col tasto sinistro e poi 
trascinare uno degli estremi (evidenziati con dei quadratini). 

 
ATT: nel caso di intersezioni fra collegamenti, le giunzioni sono indicate con un pallino; per 

aggiungere o rimuovere la giunzione fra collegamenti intersecanti selezionare dal menù “Place > 

Junction” (oppure cliccare sull’icona  della toolbox a destra, oppure premere il tasto “j”). 
 

Etichettatura dei nodi 

Un nodo è un punto di connessione fra due o più terminali di elementi circuitali. Una volta 
inseriti i collegamenti, si determina il numero di nodi e si assegna ad ognuno di essi un’etichetta, 
con un numero progressivo a partire da “0” (zero). Per fare ciò selezionare dal menù “Place > Net 
Alias” (oppure cliccare sull’icona  della toolbox a destra, oppure premere il tasto “n”), digitare il 
numero di riferimento del nodo, cliccare su “OK”, e infine cliccare vicino a uno dei collegamenti 
del nodo. Per nominare gli altri nodi si può cliccare nuovamente sull’icona  (oppure premere il 
tasto “n”) inserire il numero di riferimento del nuovo nodo, e poi applicarlo come prima. Per 
terminare l’immissione delle etichette premere il tasto “ESC”. 

 
ATT: nel caso che due o più nodi siano indicati con la stessa etichetta PSpice li considera come 

collegati da un cortocircuito. 
 
ATT: è NECESSARIO che almeno uno dei nodi del circuito sia identificato con l’etichetta “0” 

(zero). Questo nodo viene usato da PSpice come nodo di riferimento a potenziale nullo. In caso 
contrario quando si lancia la simulazione PSpice emetterà un segnale di errore del tipo “ERROR - 
Node X is floating”. Occorre in particolare fare attenzione nel caso di circuiti non connessi: in 
questo caso in ciascuno dei circuiti occorre indicare un nodo di riferimento, oppure collegare fra 
loro le sottoreti con dei cortocircuiti (o dei generatori indipendenti di tensione, se sono note le 
tensioni fra le sottoreti). 
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Creazione della NetList 

Una volta realizzato il circuito, dal menù selezionare “PSpice > Create Netlist”: il sistema esegue 
un controllo del circuito e poi crea la netlist (un file di testo che viene salvato con lo stesso nome 
dello schematico ed estensione “.net”, e che contiene tutte le informazioni relative ai componenti e 
ai collegamenti necessarie alla soluzione del circuito). Il file di netlist viene indicato sotto la cartella 
“Outputs” del project manager. Questo avviene se il test del circuito è positivo; se invece c’è 
qualche errore viene aperta una finestra che comunica di controllare gli errori riportati nella 
“session log”. Per visualizzarla, dal menù selezionare “Windows > Session Log”, e apportare le 
modifiche relative agli errori riportati (la “session log” è un file progressivo che contiene tutti i 
messaggi relativi alla sessione di lavoro, per trovare gli ultimi errori riportati controllare le ultime 
righe del log). Una volta corretti gli errori eseguire nuovamente la netlist finché non viene 
visualizzata la finestra di errore. 

 

Impostare la simulazione del circuito 

La simulazione del circuito può essere lanciata solo dopo averla descritta. Nel caso di un nuovo 
progetto occorre prima creare un nuovo “simulation profile”, selezionando dal menù “PSpice > 

New Simulation Profile” (oppure cliccare sull’icona  della toolbox in alto). Viene richiesto un 
nome per il profilo, e viene creato un file con estensione “.sim”. Il file del profilo viene indicato 
sotto la cartella “Simulation Profiles” del project manager. Viene aperta la finestra per le 
impostazioni della simulazione: per la simulazione degli esercizi di elettrotecnica eseguiremo solo 
simulazioni di tipo “transent” nel dominio del tempo, e le uniche impostazioni da modificare sono 
alla voce “Run to time” (tempo di simulazione) e “Maximum step size” (va scelto con attenzione 
nel caso di circuiti AC: indicativamente si può porre uguale a 1/200 del periodo, cioè ad esempio 
“0.1m” nel caso di frequenza di 50Hz). 

Se invece un profilo di simulazione è già presente nel progetto, è possibile modificare le 
impostazioni selezionando dal menù “PSpice > Edit Simulation Profile” (oppure cliccare sull’icona 

 della toolbox in alto, oppure cliccando col tasto destro sul nome del profilo nel project manager 
e selezionando dal menù contestuale “Edit Simulation Settings”). È possibile creare più profili di 
simulazione, ma non è consigliabile. 

 

Eseguire la simulazione del circuito 

Per eseguire la simulazione del circuito selezionare dal menù “PSpice > Run” (oppure cliccare 

sull’icona  della toolbox in alto, oppure cliccando col tasto destro sul nome del profilo nel 
project manager e selezionando dal menù contestuale “Simulate Selected Profile(s)”). Viene 
automaticamente lanciato il programma per il tracciamento dei risultati “PSpice AD”. Se ci sono 
errori nella simulazione vengono riportati nella casella in basso a sinistra di “PSpice AD”. 

 

Visualizzare i risultati della simulazione 

Il programma “PSpice AD” permette di tracciare i grafici dei risultati delle simulazioni, o di 
funzioni di questi. Per aggiungere una traccia al diagramma selezionare dal menù “Trace > Add 

Trace” (oppure cliccare sull’icona  della toolbox in alto, oppure premere il tasto “INS”). Viene 
aperta una finestra con una lista di possibili tensioni e correnti da visualizzare: è sufficiente fare 
click sugli elementi di tale serie per aggiungere un segnale alla lista di segnali che verranno 
rappresentati, che viene scritta sotto nella casella “Trace Expression”. Premendo il tasto OK tali 
curve vengono rappresentate. Ad esempio, per tracciare la tensione del nodo 1 selezionare “V(1)”. 
Per tracciare la corrente attraverso il resistore R1 (con verso positivo secondo la convenzione 
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dell’utilizzatore) selezionare “I(R1)”. Per tracciare la corrente attraverso il generatore V1 (sempre 
con verso positivo secondo la convenzione dell’utilizzatore) selezionare “I(V1)”. 

È possibile tracciare funzioni dei segnali inserendole nella casella “Trace Expression” che si 
trova in basso nella finestra “Add Trace”. Ad esempio, per tracciare la tensione fra il nodo 1 e il 
nodo 2 scrivere “V(1)-V(2)”, oppure “V(1,2)”. Se il resistore R1 ha morsetto positivo collegato al 
nodo 4 e morsetto negativo collegato al nodo 7, allora è possibile tracciare il diagramma della 
potenza assorbita da R1 inserendo “I(R1)*V(4,7)”. Nella colonna a destra della finestra “Add 
Trace” è riportato l’elenco delle funzioni che possono essere applicate ai segnali. In particolare la 
funzione “AVG” calcola il valore medio mentre “RMS” calcola il valore efficace. Per modificare 
una traccia cliccare due volte sulla sua espressione (riportata sotto l’asse delle ascisse del 
diagramma). 

È possibile aggiungere un diagramma alla finestra selezionando dal menù “Plot > Add Plot to 
Window”, o rimuoverlo selezionando “Plot > Delete Plot”. Oppure aggiungere altre finestre con 
“Window > New Window”. Per selezionare il plot attivo cliccare su di esso (viene mostrato 
“SEL>>” accanto al plot attivo). Selezionando dal menù “Plot > Axis Settings” si possono 
impostare le opzioni di scala degli assi del diagramma selezionato. 

Per ricavare con precisione i valori numerici sui diagrammi utilizzare lo strumento cursore 

selezionando dal menù “Trace > Cursor > Display” (oppure cliccare sull’icona  della toolbox in 
alto). Sono disponibili due cursori (“A1” e “A2”), rispettivamente trascinabili sul diagramma 
tenendo premuto il tasto sinistro oppure destro del mouse. I valori numerici sono riportati sulla 
finestra “Probe Cursor”, assieme alla differenza fra i due (“dif”). Quando sono presenti più tracce è 
possibile spostare il cursore “A1” oppure “A2” rispettivamente cliccando col tasto sinistro oppure 
destro del mouse sul simbolo della traccia (riportato sotto l’asse delle ascisse). Un quadratino 
attorno al simbolo indica la traccia cui si riferisce il cursore. L’uso contemporaneo dei due cursori 
risulta particolarmente utile ad esempio per determinazione lo sfasamento fra due tracce sinusoidali. 

 

Altre informazioni sull’uso di PSpice 

L’uso di PSpice è considerato di ausilio allo studente, e non viene considerato ai fini del 
superamento dell’esame. Il presente documento rappresenta solo una breve introduzione all’uso di 
PSpice. Se interessati all’approfondimento dell’uso di PSpice per la simulazione di circuiti elettrici, 
si consiglia il seguente teso: 

F. J. Monssen, “Laboratorio di circuiti elettrici con OrCAD PSpice”, Apogeo, 2003. 
 


